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1 Introduction 
1.1 Manuals and Help 

The following sources of information help you learn Nigra, your software for the evaluation of 
levellings. 

Getting Started Guide. The book you are reading now. The Getting Started Guide contains 
a general overview, system requirements, installation instructions and first steps to use 
Nigra. 

Reference Manual. The reference manual is available as .PDF file to read or print with 
Acrobat Reader. The manual contains detailed technical information for all Nigra items. 

Online Help. To access the Nigra help, press the F1 key in Nigra.  

If you are updating from Delta/DOS or Nigra/DOS, the chapter from Nigra/DOS to Nigrawin 
is very important. 

1.2 Getting Product Support 

If you can't find an answer in the section Questions and Answers in the online reference or 
on our website http://www.trukksoft.de, write an e-mail with your question to 
mail@trukksoft.de or send a fax to 49 (0) 2241 9237290. We can only answer if your ques-
tion is in English or German language. 

1.3 General Overview 

Nigra is a special software for the registration and evaluation of all kinds of levellings. With its 
additional programs Nivnet, it covers almost the complete user spectrum for levellings. 

Nigra runs under the operating systems Windows 7/8/8.1 and 10. 

Nigra has international features: The texts for all printouts are stored in separate data files 
and may be adapted by the user. Files for the languages English and German are included. 
Evaluations may be performed in meters, feet or inches. 

The core of the program is the calculation of levellings performed with digital levelling instru-
ments (Leica, Trimble (Zeiss), Topcon, SOKKIA). Manual data entry can be done with the 
text editor in the measurement data file. 

Nigra computes different kinds of levellings: levelling with side shots, line levelling, line 
adjustment and instrument testing. 

The Nigra Height Database in the Microsoft Access-Format can store approximately 10 Mio. 
points per job. There is an interface for the import of heights from any text files and for the 
export of heights in the ASCII format. 

Movement measurements may be computed automatically in list form or as movement 
diagrams. 

Profiles can be established either from levelling data or from tachymeter data in the Y,X,Z 
format. 
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1.4 Installing Nigra 

Before installation: Make sure that the latest Windows updates are installed on your com-
puter.  

Close all running applications. Insert the Nigra CD-ROM into the CD drive. If the Nigra setup 
does not start automatically, navigate to the appropriate folder, and run setup.exe. 

Then click on the OK button. The installation starts. 

If you got the Nigra setup from a download, unzip the zip file, and start setup.exe. 

Follow the setup instructions on the screen. If you have already installed an older Nigra 
version, choose a different installation folder for Nigra version 7.0 and higher than for the 
earlier versions. This way you can continue to work with both versions in parallel for a while 
and gradually switch to Nigra 7.0. 

When updating a Windows version of Nigra from 7.0, install Nigra in the same folder as the 
previous version. 

Nigra requires the .Net Framework 4.7.2 or higher to run. If this is not available on your PC, it 
must be installed separately. 

After the installation is complete, an entry is created in the Start menu and an icon on the 
desktop. Double-click on the Nigra icon to start Nigra. 

After installation: The Nigra templates folder is installed by default in c:\programs 
(x86)\nigra\templates. Copy the complete folder to another location (drive or folder) where 
you have full access rights. Then change the template folder entry in Nigra under Options, 
Program Configuration, Misc. to the new folder. 

c:\programs (x86)\nigra = Nigra installation folder 

 

1.5 Uninstalling Nigra 

To uninstall Nigra, proceed as follows: 

Click on the item Settings in the Start menu, then on Control Panel. Make a double-click on 
the icon Add/Remove Programs. In the box below select the line which contains the name 
of the Nigra software and click on the button Add/Remove. In the dialog box Select Unin-
stall Mode select Automatic and click the Next button. Then follow the description in the 
following dialog boxes. 

All files installed by Nigra will be removed. Files which are created after installation of Nigra 
will not be deleted. Therefore, the Nigra folder will not be deleted. You can remove this folder 
manually after the uninstall procedure has finished. 

1.6 Starting Nigra 

Start Nigra by clicking on the Nigra icon in the program’s menu. 

1.7 Quitting Nigra 

You quit Nigra by clicking on Exit in the File menu. Alternatively, you may quit Nigra by 
pressing the keys [Ctrl]+[F4] if all Nigra windows are closed. 
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1.8 From Delta/DOS or Nigra/DOS to Nigrawin 

This section is intended for users who have already worked with Delta/DOS and want to 
transfer their data and files into Nigrawin. You will quickly feel at home in Nigrawin if you 
have previously worked with Delta /DOS, since the basic application structure is similar. 

Differences between Nigrawin and Delta /DOS 

Many differences between Delta /DOS and Nigrawin are based on differences between DOS 
and Windows. Windows, for example, uses a different font than DOS. Consequently, all DOS 
fonts with an ASCII value > 127 are presented differently in Windows. This also applies to the 
German 'umlauts', or vowel changes. You may transfer DOS text files into Windows format 
with the Nigra function Convert ASCII → ANSI (File menu). Unfortunately, there is a small 
problem: The Windows font does not include all DOS symbols. 

The special user administration for Delta/DOS has been given up. You may now work in any 
folder with Nigrawin. 

The job file with the measurement data ('job'.DAT) from Delta/DOS is compatible with 
'job'.NIG from Windows. You should, however, use the ASCII → ANSI conversion once to 
make sure that the German 'umlauts' are correctly presented. To convert the file extension 
.DAT to .NIG, use the function Program Configuration in the Options menu. 

The Nigra height database is not compatible. This file has a different database format and an 
extended data structure in Nigrawin. 

You may transfer your old heights into Nigrawin without any problem: Export the heights as 
an ASCII file in Delta/DOS and import them into Nigrawin via the ASCII interface. The table 
below shows the differences in the data structure: 

 
Data Field Nigrawin Delta/DOS 

Date 10 characters, e.g., 10-15-2010 8 characters, e.g., 10-15-10 

Remarks/ 
Comments 

max. 30 characters max. 19 characters 

Y-coordinate Y-coordinate not available 

X-coordinate X-coordinate not available 

 

All remaining data fields have the same data format as in Delta/DOS. The coordinates are 
not computed at this time but are only recorded and stored. Thus, you may import available 
3D data without loss to Nigra and subsequently re-export them. 

The Nigrawin height database (file extension .MDB) is compatible with the Microsoft Access 
database. You can access the Nigra database with MS Access, for example, to create 
special database reports. In this case, you should always work with a copy and not with the 
original database! 

All texts for printouts, for example, headers for calculations and height database, are not an 
integral part of the program. They are in an external file with the file extension .LAG and may 
be adapted by the user according to his own requirements. They serve mainly for the adapta-
tion into various languages. 

The files ENGLISH.LAG for English texts and DEUTSCH.LAG for German texts are included. 
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All calculations may be performed in meters, feet or inches, as desired. 

An editor for editing the measurement data and other ASCII files is an integral part of 
Nigrawin. You may, however, use your own editor. 

1.9 Update from Nigrawin < 5.0 

While earlier versions of Nigrawin are developed with MS Visual Basic 6, the MS Visual 
Studio development environment is used from version 5.0. After the installation from an 
earlier version, all program and project parameters must be redefined. 

Many parts of the program had to be developed completely new. This concerns primarily the 
Nigra height file, the editor and printing. The proven menu design was retained, so you can 
find your way in the new Nigra quickly. 

Since the first version of Nigrawin the height database had the MS Access database format 
97. From Nigra-Version 5 the Access format 2000 – 2007 is used. Existing height files must 
not be converted, new projects will be created in the new file format. The display of the 
height file on the screen is only possible in the unit of meters. 

The functions for the Manual Calculation and the REC500 are no longer available, also the 
menu bars Repair Height File and Compress height file. 

Project and application settings are now stored in .XML files. The definition of the serial 
interface for data transfer is now in the dialog box of each data transfer. 
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2 First Steps 
2.1 Setting Program Parameters 

When first starting Nigra, it is advisable to make some program customizations and alter the 
standard parameters. Select the Program Configuration item in the Options menu. The 
parameters are stored separately for each user. 

Setting Program Parameters 

The individual input fields have the following functions: 

Company - Name of Company defines a header for all printouts (for example, company 
name and address). 

Header graphics allows defining a graphics to be printed in the head of a printout (calcula-
tion, movement list, etc.) in addition to the company name. Graphics name defines the 
complete file name of the graphics (including drive and folder). Alternatively, you can double-
click on the input field or click on the button on the right side to open a selection dialog box. 

In the field Graphics dimension, you can define the size of the graphic (width and height). If 
these values differ from the original graphic size, the graphic will be resized in the printout. 

The graphic will be printed with right justification. If you print from the editor, the graphics will 
not be printed. 

Error Limits: 

Error limits defines the boundary values according to the most used formula: (example of unit 
of measurement "meters") 
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        Misclosure E (in mm) = a + b * D (in km) 

(a = constant error part in mm, b = systematic error part in mm, D = levelling distance in km) 

 

The error limits for the four error classes can be defined in free formula style as a function of 
the levelling distance D, for example, 2 + 3*Sqrt(D). "Sqrt" means square root and D the 
levelling distance in km. In modification of this standard formula, you can also calculate, for 
example, the term 2 + 3*Sqrt(D/2). 

When reformatting the digital level raw data, you may choose the error class as required. 

Admissible difference between forward and back levelling 

When creating a network file with double levellings measured, the difference is calculated 
and compared with the permissible difference. 

If you have chosen the unit of measurement "feet" or "inches", error limits will also be entered 
in these units. 

Programs: 

Transfer programs for Digital Levels: Here an entry is only required if you do not want to 
use the integrated Nigra data transfer. Enter the name of the transfer program supplied by 
your manufacturer, including file extensions. 

Editor name: An entry is only required if you do not want to use the text editor integrated in 
Nigra. In any case, the editor must be a Windows program, for example, the word processor 
WRITE. The editor must be entered completely with drive and path, for example, 
c:\winnt\system32\write.exe. 

A click on the buttons on the right will display a dialog box for selecting a program. 

In addition to these program parameters, special parameters can be defined for each job. To 
do this, however, a particular job must be opened. How to open and start jobs is described in 
section 2.2. 
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Miscellaneous (Misc.). 

 

Program Language: The language of Nigra (for menus, dialog boxes, and Help) can be 
switched between English and German. The texts for printings will not be hereby changed 
automatically. 

Nigra Background Color: Defining the individual color for the Nigra background. 

.DAT → .NIG: Changes all file extension in the current folder from .DAT to .NIG. From 
Nigrawin Rev. 2.0, .NIG is the file extension for Nigra job files with measurement data. 

Folder for Templates: With this function you choose a folder for the template files (eng-
lish.lag, dinicode.txt etc.). The default folder created during the Nigra installation is 
c:\program files\Nigra\TEMPLATES. 

Before using this option, create the new folder and copy all files from c:\program 
files\Nigra\TEMPLATES to this folder. 

c:\program files\Nigra = Nigra installation folder 

Job folder: With this entry you can choose a folder which will be shown while opening a 
project. 

When all data have been entered, click OK. 

2.2 Opening/New Job 

Nigra works job oriented. This greatly facilitates the subsequent handling of the program, as 
all operations, for example, calculations, refer to this job, and the required parameters and 
data files are created and selected automatically. 

After starting Nigra, first create a new job or open an existing one. Choose from the File 
menu Open/New Job .... You may start a new job in any given folder by entering a job 
name or choosing an existing job (with the file extension .NIG). 
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The job name will be shown, complete with the full path name, in the header of the Nigra 
window. 

 

Opening Job 

The last 6 jobs opened appear in the bottom item of the File menu. If you want to use one of 
these jobs, click on the desired item. 

Several jobs may be processed within one folder. Larger jobs, however, should always be 
processed in a separate folder. 

When setting up a new job, a file is opened with the chosen job name and the file extension 
.NIG with the following contents: 

In this file your measurement data will be stored, and it is the basis for batch processing. The 
first four lines are for a better orientation, in case measurement data must be edited. Acci-
dental deletion of this lines is of no importance for further processing. 

Apart from these job files there are also job-unconnected files, for example, the raw data 
after transfer to the PC. They will be allocated to a job only after being reformatted into the 
Nigra format. 

  

ROptional text for job description up to column 72                             

x23456789012345678901234567890123456789012345678901234567890123456789012   

x        1         2         3         4         5         6         7     

xDistance<--- Back    Side    Fore ---><--- Point Number --->              
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2.3 Individual Configuration 

The individual configuration (in the Option menu, item Job Configuration) enables the user 
to adapt the program configuration to his special job. 

The individual configuration is valid for the job in use and all further jobs to be processed in 
the same folder. With this configuration you may, for example, define the units of measure-
ment (meters, feet, inches), the country-specific file for the printouts or other preset 
parameters. 

If you create a job in a new folder, the last used job parameters are transferred to the new 
folder. 

Defining Individual Configuration 

Reorganize calculations numbers automatically 

Check box activated: The running levelling calculation numbers are automatically renum-
bered after each reformatting of raw data. 

Show point number extension for digital levels 

Check box activated: Shows the input field for point number extension when reformatting raw 
data. 

Print header graphics 

Check box activated: Header graphics chosen in the program configuration will be used in all 
Nigra printouts. 

Lines per page for calculations, height lists, etc. 

Fixes the number of lines per printed page before Nigra performs a form feed. 
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Recommended settings for the selected font Courier New, 10 points: 60 lines per page. The 
extra lines required for a selected header graphic Nigra automatically considered when 
creating the file. 

Text file for printouts 

All texts to be printed are taken from an ASCII file with the file extension .LAG. Standard files 
supplied with Nigra are DEUTSCH.LAG and ENGLISH.LAG. The files use the following 
format: 

*  Point Number    Height  Calc.No. Diff. NC  Date        Comments 

69,Point Number    Height  Calc.No. Diff. NC  Date        Comments 

The syntax is: running number, Text. Lines starting with the asterisk (*) contain comments 
and are skipped. In the example, the text (header for a height report) separated by a comma 
is allocated to the number 69. 

If you want to alter texts, do not alter the supplied files DEUTSCH.LAG or ENGLISH.LAG, 
but copy them, for example, in the file ENGLISH1.LAG and alter the newly created file. In this 
way you will avoid that your texts will be overwritten by future Nigra updates. It is possible to 
create more language files using the same method and to select them in this dialog box. 

Nigra does not work directly with the selected file *.LAG, but with an automatically created 
file Text.XML. After a text modification, this file must be created new by clicking on the button 
Update Text Database. 

Note: 
Self-created text files may have to be updated after the installation of a Nigra update. Com-
pare your own file with the file ENGLISH.LAG or DEUTSCH.LAG. 

Units of measurement 

Nigra operates with meters, feet, and inches. After program installation, the standard preset 
unit of measurement is always meters. In case you want to work with another unit, it can be 
defined in the dialog box Units of measurement. 

When reformatting the raw data of the digital level, all measurement data are automatically 
converted into the chosen unit of measurement in case measurements were taken in another 
unit of measurement by mistake. 

Although the height database originally uses meters as the unit of measurement, the in- and 
output of heights can alternatively be made in feet or inches (except heights on the screen). 
Conversion factors for units of measurement: 

Meter = Feet*1200/3937       Meter = Inch/39.37 

Feet  = Meter*3937/1200      Feet  = Inch/12 

Inch  = Meter*39.37          Inch  = Feet*12 

The unit of measurement feet above means 'US feet' (also known as U.S. Survey Feet). The 
Leica DNA levels and the Sokkia SDL1X/Topcon DL-501 also knows the unit of measure-
ment 'international feet' (conversion factor meter in feet = 1/0.3048). When using this unit of 
measurement with a DNA/LS-level and choosing meters in Nigra, the results will be wrong. 
When using 'international feet' with a level, choose feet in Nigra every time and don't change 
the unit of measurement. 
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2.4 Levelling with Digital Levels 

If you want to calculate with levelling data obtained from a digital level and registered in a 
data storage, the following steps must be taken: 

• Transfer the data to the computer 

• Reformat the raw data into the special Nigra format 

• Enter the heights of the fix points.  

• Start calculation. 

Click the Leica, Trimble, Topcon or SOKKIA icon or select the item Leica, Trimble, Top-
con or SOKKIA from the Digital Level menu. 

From the following submenu select first the item GIF 10  PC, NA/DNA/Sprinter Raw Data 

 PC , DiNi Raw Data  PC, DL-100 Raw Data → PC or SDL Raw Data → PC to transfer 
the raw data to the PC. Follow the instructions on the monitor screen. Add the file extension 
.NA2, .GSI or .DNA to the raw data file for Leica data, .DIN for Trimble data, .TOP for Topcon 
data and .SOK for SOKKIA format. 

Subsequently, the data transmitted to the PC are reformatted into the Nigra format with the 
menu item Format NA/DNA/LS/Sprinter-GSI → Nigra, Format DiNi Rec E → Nigra, 
Format DL-100 → Nigra or Format SDL → Nigra. A dialog box for the selection of the file 
name for the raw data file appears on the screen. 

In the following dialog box for reformatting use the Measurements option to transfer the raw 
in the Nigra measurement file. Then select or enter parameters or header data by clicking 
Parameters and Header data. 

Reformatting Raw Data 
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Entry of Parameters: 

Take your time and select the appropriate parameters carefully. A detailed description of the 
parameters is given in technical reference. 

Entry of Header Data 

When all entries are completed, click on OK or Exit. 

Reformatting is started by clicking Run in the dialog box for Reformatting Raw Data. The 
lines of your raw data as read by Nigra will be displayed on the screen. After reformatting, 
the individual levellings are automatically numbered with consecutive calculation numbers. 

There may still be some point numbers to be corrected or lines to be deleted. Click the editor 
icon to edit your measurement data file. Alternatively, corrections can also be made in 
advance in the raw data file. 
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Enter the heights of the reference bench marks in the menu item Enter Heights in the 
Heights menu, then click the button for batch calculation. The following dialog box will 
appear:  

Starting Batch Calculation 

Enter the first and last calculation number and start batch calculation by clicking Run. After 
completion of the calculations, click the button for edit calculations to display the calculations 
on the screen. 

You can print the calculation from the editor or close the editor and print with the print button. 
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